






[image: PDFHALL.COM]






Menu





	 maison
	 Ajouter le document
	 Signe
	 Créer un compte







































X Series User Manual - HUIT Sites Hosting

support phone numbers, email addresses, and current events. National ... National Instruments does not warrant that the operation of the software shall be uninterrupted or error free. ...... The NI-DAQ Readme lists which devices, ADEs, and NI application ... labview\manuals directory and opening LV_Getting_Started.pdf. 

















 Télécharger le PDF 






 9MB taille
 48 téléchargements
 346 vues






 commentaire





 Report




















DAQ X Series X Series User Manual NI 632x/634x/635x/636x Devices X Series User Manual



Français



Deutsch ni.com/manuals



February 2012 370784D-01



Support Worldwide Technical Support and Product Information ni.com Worldwide Offices Visit ni.com/niglobal to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events. National Instruments Corporate Headquarters 11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100 For further support information, refer to the Technical Support and Professional Services appendix. To comment on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter the Info Code feedback. © 2009–2012 National Instruments. All rights reserved.



Important Information Warranty X Series devices are warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the warranty period. This warranty includes parts and labor. The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free. A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty. National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it. EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.



Copyright Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation. National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.



Trademarks CVI, LabVIEW, National Instruments, NI, ni.com, the National Instruments corporate logo, and the Eagle logo are trademarks of National Instruments Corporation. Refer to the Trademark Information at ni.com/trademarks for other National Instruments trademarks. The mark LabWindows is used under a license from Microsoft Corporation. Windows is a registered trademark of Microsoft Corporation in the United States and other countries. Other product and company names mentioned herein are trademarks or trade names of their respective companies. Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, partnership, or joint-venture relationship with National Instruments.



Patents For patents covering National Instruments products/technology, refer to the appropriate location: Help»Patents in your software, the patents.txt file on your media, or the National Instruments Patent Notice at ni.com/patents.



Export Compliance Information Refer to the Export Compliance Information at ni.com/legal/export-compliance for the National Instruments global trade compliance policy and how to obtain relevant HTS codes, ECCNs, and other import/export data.



WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS (1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN. (2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER



NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



Electromagnetic Compatibility Guidelines This product was tested and complies with the regulatory requirements and limits for electromagnetic compatibility (EMC) as stated in the product specifications. These requirements and limits are designed to provide reasonable protection against harmful interference when the product is operated in its intended operational electromagnetic environment. This product is intended for use in industrial locations. There is no guarantee that harmful interference will not occur in a particular installation, when the product is connected to a test object, or if the product is used in residential areas. To minimize the potential for the product to cause interference to radio and television reception or to experience unacceptable performance degradation, install and use this product in strict accordance with the instructions in the product documentation. Furthermore, any changes or modifications to the product not expressly approved by National Instruments could void your authority to operate it under your local regulatory rules. Caution To ensure the specified EMC performance, operate this product only with shielded cables and accessories.



Contents About This Manual Conventions ...................................................................................................................xvii Related Documentation..................................................................................................xviii



Chapter 1 Getting Started Installation .....................................................................................................................1-1 Unpacking ......................................................................................................................1-1 Device Self-Calibration .................................................................................................1-2 Getting Started with X Series USB Devices..................................................................1-3 USB Device Chassis Ground...........................................................................1-3 Ferrite Installation ...........................................................................................1-4 Mounting X Series USB Devices ....................................................................1-5 Panel/Wall Mounting ........................................................................1-5 DIN Rail Mounting ...........................................................................1-6 USB Device LEDs...........................................................................................1-7 USB Cable Strain Relief..................................................................................1-7 USB Device Security Cable Slot.....................................................................1-8 Device Pinouts ...............................................................................................................1-8 Device Specifications ....................................................................................................1-8 Device Accessories and Cables .....................................................................................1-8



Chapter 2 DAQ System Overview DAQ Hardware ..............................................................................................................2-1 DAQ-STC3......................................................................................................2-2 Calibration Circuitry........................................................................................2-3 Cables and Accessories..................................................................................................2-3 PCI Express, PXI Express, and USB Mass Termination Device Cables and Accessories ............................................................................................2-3 SCXI Accessories .............................................................................2-4 SCC Accessories ...............................................................................2-5 BNC Accessories ..............................................................................2-5 Screw Terminal Accessories.............................................................2-6 RTSI Cables ......................................................................................2-6 Cables................................................................................................2-6 Custom Cabling and Connectivity ....................................................2-7 USB Device Mounting Accessories, USB Cable, Power Supply, and Ferrite ......................................................................................2-7 USB Screw Terminal Device Accessories ......................................................2-8 © National Instruments



vii



X Series User Manual



Contents



Signal Conditioning....................................................................................................... 2-8 Sensors and Transducers ................................................................................. 2-8 Signal Conditioning Options........................................................................... 2-9 SCXI ................................................................................................. 2-9 SCC................................................................................................... 2-9 Programming Devices in Software................................................................................ 2-10



Chapter 3 Connector and LED Information I/O Connector Signal Descriptions................................................................................ 3-1 +5 V Power Source........................................................................................................ 3-3 PCI Express Device Disk Drive Power Connector ....................................................... 3-4 When to Use the Disk Drive Power Connector .............................................. 3-4 Disk Drive Power Connector Installation ....................................................... 3-4 RTSI Connector Pinout ................................................................................................. 3-5 USB Device LED Patterns ............................................................................................ 3-5



Chapter 4 Analog Input Analog Input on MIO X Series Devices........................................................................ 4-1 Analog Input Range ........................................................................................ 4-2 Working Voltage Range.................................................................................. 4-4 Analog Input Ground-Reference Settings....................................................... 4-4 Configuring AI Ground-Reference Settings in Software ................. 4-6 Multichannel Scanning Considerations .......................................................... 4-6 Analog Input Data Acquisition Methods ........................................................ 4-9 Software-Timed Acquisitions........................................................... 4-10 Hardware-Timed Acquisitions ......................................................... 4-10 Analog Input Triggering ................................................................................. 4-11 Connecting Analog Input Signals ................................................................... 4-11 Connecting Floating Signal Sources ............................................................... 4-13 What Are Floating Signal Sources?.................................................. 4-13 When to Use Differential Connections with Floating Signal Sources ............................................................................... 4-13 When to Use Non-Referenced Single-Ended (NRSE) Connections with Floating Signal Sources .................................... 4-13 When to Use Referenced Single-Ended (RSE) Connections with Floating Signal Sources ......................................................... 4-14 Using Differential Connections for Floating Signal Sources ........... 4-15 Using Non-Referenced Single-Ended (NRSE) Connections for Floating Signal Sources ........................................................... 4-18 Using Referenced Single-Ended (RSE) Connections for Floating Signal Sources ........................................................... 4-19



X Series User Manual



viii



ni.com



Contents



Connecting Ground-Referenced Signal Sources .............................................4-20 What Are Ground-Referenced Signal Sources?................................4-20 When to Use Differential Connections with Ground-Referenced Signal Sources ...............................................4-20 When to Use Non-Referenced Single-Ended (NRSE) Connections with Ground-Referenced Signal Sources ..................4-21 When to Use Referenced Single-Ended (RSE) Connections with Ground-Referenced Signal Sources ..................4-21 Using Differential Connections for Ground-Referenced Signal Sources................................................................................4-22 Using Non-Referenced Single-Ended (NRSE) Connections for Ground-Referenced Signal Sources .........................................4-23 Field Wiring Considerations............................................................................4-24 Analog Input Timing Signals ..........................................................................4-24 Aggregate versus Single Channel Sample Rates ..............................4-27 AI Sample Clock Signal....................................................................4-28 AI Sample Clock Timebase Signal ...................................................4-30 AI Convert Clock Signal...................................................................4-31 AI Convert Clock Timebase Signal ..................................................4-34 AI Hold Complete Event Signal .......................................................4-34 AI Start Trigger Signal......................................................................4-35 AI Reference Trigger Signal .............................................................4-37 AI Pause Trigger Signal ....................................................................4-38 Getting Started with AI Applications in Software ..........................................4-40 Analog Input on Simultaneous MIO X Series Devices .................................................4-41 Analog Input Terminal Configuration.............................................................4-42 Analog Input Range.........................................................................................4-42 Working Voltage Range ..................................................................................4-43 Analog Input Data Acquisition Methods.........................................................4-44 Analog Input Triggering..................................................................................4-46 Connecting Analog Input Signals....................................................................4-46 Types of Signal Sources....................................................................4-47 Differential Connections for Ground-Referenced Signal Sources....4-48 Differential Connections for Floating Signal Sources ......................4-49 Field Wiring Considerations............................................................................4-51 Minimizing Drift in Differential Mode .............................................4-51 Analog Input Timing Signals ..........................................................................4-52 Aggregate versus Single Channel Sample Rates ..............................4-53 AI Sample Clock Signal....................................................................4-54 AI Sample Clock Timebase Signal ...................................................4-56 AI Hold Complete Event Signal .......................................................4-57 AI Start Trigger Signal......................................................................4-57 AI Reference Trigger Signal .............................................................4-59 AI Pause Trigger Signal ....................................................................4-61 Getting Started with AI Applications in Software ..........................................4-62



© National Instruments



ix



X Series User Manual



Contents



Chapter 5 Analog Output AO Reference Selection ................................................................................................ 5-2 Minimizing Glitches on the Output Signal.................................................................... 5-3 Analog Output Data Generation Methods..................................................................... 5-3 Software-Timed Generations .......................................................................... 5-3 Hardware-Timed Generations......................................................................... 5-3 Analog Output Triggering ............................................................................................. 5-5 Connecting Analog Output Signals ............................................................................... 5-5 Analog Output Timing Signals...................................................................................... 5-6 AO Start Trigger Signal .................................................................................. 5-7 Retriggerable Analog Output............................................................ 5-7 Using a Digital Source...................................................................... 5-7 Using an Analog Source ................................................................... 5-8 Routing AO Start Trigger Signal to an Output Terminal ................. 5-8 AO Pause Trigger Signal ................................................................................ 5-8 Using a Digital Source...................................................................... 5-9 Using an Analog Source ................................................................... 5-10 Routing AO Pause Trigger Signal to an Output Terminal ............... 5-10 AO Sample Clock Signal ................................................................................ 5-10 Using an Internal Source .................................................................. 5-10 Using an External Source ................................................................. 5-11 Routing AO Sample Clock Signal to an Output Terminal ............... 5-11 Other Timing Requirements ............................................................. 5-11 AO Sample Clock Timebase Signal................................................................ 5-12 Getting Started with AO Applications in Software....................................................... 5-13



Chapter 6 Digital I/O Digital Input Data Acquisition Methods ....................................................................... 6-2 Software-Timed Acquisitions ......................................................................... 6-2 Hardware-Timed Acquisitions ........................................................................ 6-3 Digital Input Triggering ................................................................................................ 6-4 Digital Waveform Acquisition ...................................................................................... 6-5 DI Sample Clock Signal.................................................................................. 6-6 Using an Internal Source .................................................................. 6-6 Using an External Source ................................................................. 6-6 Routing DI Sample Clock to an Output Terminal ............................ 6-7 Other Timing Requirements ............................................................. 6-7 DI Sample Clock Timebase Signal ................................................................. 6-7



X Series User Manual



x



ni.com



Contents



DI Start Trigger Signal ....................................................................................6-8 Retriggerable DI................................................................................6-8 Using a Digital Source ......................................................................6-9 Using an Analog Source ...................................................................6-10 Routing DI Start Trigger to an Output Terminal ..............................6-10 DI Reference Trigger Signal ...........................................................................6-10 Using a Digital Source ......................................................................6-11 Using an Analog Source ...................................................................6-12 Routing DI Reference Trigger Signal to an Output Terminal ..........6-12 DI Pause Trigger Signal ..................................................................................6-12 Using a Digital Source ......................................................................6-13 Using an Analog Source ...................................................................6-13 Routing DI Pause Trigger Signal to an Output Terminal .................6-13 Digital Output Data Generation Methods ......................................................................6-14 Software-Timed Generations...........................................................................6-14 Hardware-Timed Generations .........................................................................6-14 Digital Output Triggering ..............................................................................................6-16 Digital Waveform Generation .......................................................................................6-16 DO Sample Clock Signal.................................................................................6-17 Using an Internal Source...................................................................6-17 Using an External Source..................................................................6-17 Routing DO Sample Clock to an Output Terminal...........................6-18 Other Timing Requirements..............................................................6-18 DO Sample Clock Timebase Signal ................................................................6-18 DO Start Trigger Signal...................................................................................6-19 Retriggerable DO ..............................................................................6-19 Using a Digital Source ......................................................................6-20 Using an Analog Source ...................................................................6-20 Routing DO Start Trigger Signal to an Output Terminal..................6-20 DO Pause Trigger Signal.................................................................................6-21 Using a Digital Source ......................................................................6-22 Using an Analog Source ...................................................................6-22 Routing DO Pause Trigger Signal to an Output Terminal................6-22 I/O Protection.................................................................................................................6-23 Programmable Power-Up States ....................................................................................6-23 DI Change Detection .....................................................................................................6-24 DI Change Detection Applications..................................................................6-25 Digital Filtering..............................................................................................................6-25 Watchdog Timer..............................................................................................6-28 Connecting Digital I/O Signals......................................................................................6-29 Getting Started with DIO Applications in Software ......................................................6-30



© National Instruments



xi



X Series User Manual



Contents



Chapter 7 Counters Counter Timing Engine ................................................................................................. 7-2 Counter Input Applications ........................................................................................... 7-3 Counting Edges ............................................................................................... 7-3 Single Point (On-Demand) Edge Counting ...................................... 7-4 Buffered (Sample Clock) Edge Counting......................................... 7-5 Controlling the Direction of Counting.............................................. 7-5 Pulse-Width Measurement .............................................................................. 7-6 Single Pulse-Width Measurement .................................................... 7-6 Implicit Buffered Pulse-Width Measurement................................... 7-7 Sample Clocked Buffered Pulse-Width Measurement ..................... 7-8 Hardware-Timed Single Point Pulse-Width Measurement .............. 7-8 Pulse Measurement ......................................................................................... 7-9 Single Pulse Measurement................................................................ 7-9 Implicit Buffered Pulse Measurement .............................................. 7-10 Sample Clocked Buffered Pulse Measurement ................................ 7-10 Hardware-Timed Single Point Pulse Measurement.......................... 7-11 Pulse versus Semi-Period Measurements ......................................... 7-11 Semi-Period Measurement .............................................................................. 7-12 Single Semi-Period Measurement .................................................... 7-12 Implicit Buffered Semi-Period Measurement................................... 7-12 Frequency Measurement ................................................................................. 7-13 Low Frequency with One Counter ................................................... 7-13 High Frequency with Two Counters ................................................ 7-14 Large Range of Frequencies with Two Counters ............................. 7-15 Sample Clocked Buffered Frequency Measurement ........................ 7-16 Hardware-Timed Single Point Frequency Measurement ................. 7-18 Choosing a Method for Measuring Frequency ................................. 7-18 Period Measurement ....................................................................................... 7-22 Position Measurement..................................................................................... 7-23 Measurements Using Quadrature Encoders...................................... 7-23 Measurements Using Two Pulse Encoders ...................................... 7-25 Buffered (Sample Clock) Position Measurement ............................. 7-25 Hardware-Timed Single Point Position Measurement ..................... 7-26 Two-Signal Edge-Separation Measurement ................................................... 7-26 Single Two-Signal Edge-Separation Measurement.......................... 7-27 Implicit Buffered Two-Signal Edge-Separation Measurement ........ 7-28 Sample Clocked Buffered Two-Signal Separation Measurement .... 7-28 Hardware-Timed Single Point Two-Signal Separation Measurement.................................................................................. 7-29



X Series User Manual



xii



ni.com



Contents



Counter Output Applications .........................................................................................7-30 Simple Pulse Generation .................................................................................7-30 Single Pulse Generation ....................................................................7-30 Single Pulse Generation with Start Trigger ......................................7-31 Pulse Train Generation ....................................................................................7-31 Finite Pulse Train Generation ...........................................................7-32 Retriggerable Pulse or Pulse Train Generation.................................7-33 Continuous Pulse Train Generation ..................................................7-34 Buffered Pulse Train Generation ......................................................7-35 Finite Implicit Buffered Pulse Train Generation ..............................7-35 Continuous Buffered Implicit Pulse Train Generation .....................7-36 Finite Buffered Sample Clocked Pulse Train Generation.................7-36 Continuous Buffered Sample Clocked Pulse Train Generation........7-38 Frequency Generation .....................................................................................7-38 Using the Frequency Generator ........................................................7-38 Frequency Division .........................................................................................7-39 Pulse Generation for ETS................................................................................7-40 Counter Timing Signals .................................................................................................7-41 Counter n Source Signal..................................................................................7-41 Routing a Signal to Counter n Source...............................................7-42 Routing Counter n Source to an Output Terminal ............................7-42 Counter n Gate Signal .....................................................................................7-43 Routing a Signal to Counter n Gate ..................................................7-43 Routing Counter n Gate to an Output Terminal................................7-43 Counter n Aux Signal ......................................................................................7-43 Routing a Signal to Counter n Aux...................................................7-44 Counter n A, Counter n B, and Counter n Z Signals.......................................7-44 Routing Signals to A, B, and Z Counter Inputs ................................7-44 Routing Counter n Z Signal to an Output Terminal..........................7-44 Counter n Up_Down Signal ............................................................................7-44 Counter n HW Arm Signal ..............................................................................7-45 Routing Signals to Counter n HW Arm Input...................................7-45 Counter n Sample Clock Signal ......................................................................7-45 Using an Internal Source...................................................................7-46 Using an External Source..................................................................7-46 Routing Counter n Sample Clock to an Output Terminal.................7-46 Counter n Internal Output and Counter n TC Signals .....................................7-47 Routing Counter n Internal Output to an Output Terminal...............7-47 Frequency Output Signal.................................................................................7-47 Routing Frequency Output to a Terminal .........................................7-47 Default Counter/Timer Pinouts......................................................................................7-47 Counter Triggering ........................................................................................................7-50



© National Instruments



xiii



X Series User Manual



Contents



Other Counter Features.................................................................................................. 7-51 Cascading Counters......................................................................................... 7-51 Prescaling ........................................................................................................ 7-51 Synchronization Modes................................................................................... 7-52 100 MHz Source Mode..................................................................... 7-52 External Source Greater than 25 MHz.............................................. 7-52 External or Internal Source Less than 25 MHz ................................ 7-53



Chapter 8 PFI Using PFI Terminals as Timing Input Signals .............................................................. 8-2 Exporting Timing Output Signals Using PFI Terminals............................................... 8-3 Using PFI Terminals as Static Digital I/Os ................................................................... 8-4 Using PFI Terminals to Digital Detection Events......................................................... 8-4 Connecting PFI Input Signals........................................................................................ 8-4 PFI Filters ...................................................................................................................... 8-5 I/O Protection ................................................................................................................ 8-7 Programmable Power-Up States.................................................................................... 8-7



Chapter 9 Digital Routing and Clock Generation Clock Routing................................................................................................................ 9-1 100 MHz Timebase ......................................................................................... 9-2 20 MHz Timebase ........................................................................................... 9-2 100 kHz Timebase .......................................................................................... 9-2 External Reference Clock ............................................................................... 9-2 10 MHz Reference Clock................................................................................ 9-3 Synchronizing Multiple Devices ................................................................................... 9-3 PXI Express Devices....................................................................................... 9-3 PCI Express Devices ....................................................................................... 9-3 USB Devices ................................................................................................... 9-4 Real-Time System Integration (RTSI) .......................................................................... 9-4 RTSI Connector Pinout ................................................................................... 9-5 Using RTSI as Outputs ................................................................................... 9-6 Using RTSI Terminals as Timing Input Signals............................................. 9-7 RTSI Filters..................................................................................................... 9-7 PXI and PXI Express Clock and Trigger Signals.......................................................... 9-8 PXIe_CLK100 ................................................................................................ 9-8 PXIe_SYNC100.............................................................................................. 9-8 PXI_CLK10 .................................................................................................... 9-8 PXI Triggers.................................................................................................... 9-8 PXI_STAR Trigger ......................................................................................... 9-9



X Series User Manual



xiv



ni.com



Contents



PXI_STAR Filters ...........................................................................................9-9 PXIe-DSTAR ......................................................................................9-9



Chapter 10 Bus Interface Data Transfer Methods ..................................................................................................10-1 PCI Express/PXI Express Device Data Transfer Methods..............................10-1 USB Device Data Transfer Methods...............................................................10-2 PXI Express Considerations ..........................................................................................10-3 PXI and PXI Express Clock and Trigger Signals............................................10-3 PXI Express .....................................................................................................10-3



Chapter 11 Triggering Triggering with a Digital Source ...................................................................................11-1 Triggering with an Analog Source.................................................................................11-2 APFI Terminals.....................................................................................11-3 Analog Input Channels ....................................................................................11-3 Analog Input Channels on MIO X Series Devices ...........................11-4 Analog Input Channels on Simultaneous MIO X Series Devices ....11-4 Analog Trigger Actions...................................................................................11-4 Routing Analog Comparison Event to an Output Terminal............................11-5 Analog Trigger Types ....................................................................................................11-5 Analog Trigger Accuracy ..............................................................................................11-8



Appendix A Device-Specific Information NI 6320 ..........................................................................................................................A-2 NI 6321/6341 .................................................................................................................A-5 NI 6323/6343 .................................................................................................................A-8 NI 6351/6361 .................................................................................................................A-12 NI 6353/6363 .................................................................................................................A-16 NI 6356/6366 .................................................................................................................A-22 NI 6358/6368 .................................................................................................................A-27



Appendix B Troubleshooting Appendix C Technical Support and Professional Services © National Instruments



xv



X Series User Manual



Contents



Glossary Index Device Pinouts Figure A-1. Figure A-2. Figure A-3. Figure A-4. Figure A-5. Figure A-6. Figure A-7. Figure A-8. Figure A-9. Figure A-10. Figure A-11. Figure A-12. Figure A-13. Figure A-14. Figure A-15.



X Series User Manual



NI PCIe-6320 Pinout............................................................................. A-3 NI PCIe-6321 and NI PCIe/PXIe-6341 Pinout ..................................... A-6 NI USB-6341 Pinout............................................................................. A-7 NI PCIe-6323/6343 Pinout ................................................................... A-8 NI USB-6343 Pinout............................................................................. A-10 NI PCIe-6351 and NI PCIe/PXIe-6361 Pinout ..................................... A-12 NI USB-6351/6361 Screw Terminal Pinout ......................................... A-13 NI USB-6361 Mass Termination Pinout............................................... A-14 NI PCIe-6353 and NI PCIe/PXIe-6363 Pinout ..................................... A-16 NI USB-6363 Mass Termination Pinout............................................... A-18 NI USB-6353/6363 Screw Terminal Pinout ......................................... A-20 NI PXIe-6356/6366 Pinout ................................................................... A-22 NI USB-6366 Mass Termination Pinout............................................... A-24 NI USB-6356/6366 Screw Terminal Pinout ......................................... A-25 NI PXIe-6358/6368 Pinout ................................................................... A-27



xvi



ni.com



About This Manual The X Series User Manual contains information about using the National Instruments X Series data acquisition (DAQ) devices with NI-DAQmx 9.5 and later. X Series devices feature up to 32 analog input (AI) channels, up to four analog output (AO) channels, up to 48 lines of digital input/output (DIO), and four counters.



Conventions The following conventions are used in this manual: 



Angle brackets that contain numbers separated by an ellipsis represent a range of values associated with a bit or signal name—for example, AO .



»



The » symbol leads you through nested menu items and dialog box options to a final action. The sequence Options»Settings»General directs you to pull down the Options menu, select the Settings item, and select General from the last dialog box. This icon denotes a note, which alerts you to important information. This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, or a system crash. When this symbol is marked on a product, refer to the Read Me First: Safety and Electromagnetic Compatibility for information about precautions to take.



bold



Bold text denotes items that you must select or click in the software, such as menu items and dialog box options. Bold text also denotes parameter names.



italic



Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept. Italic text also denotes text that is a placeholder for a word or value that you must supply.



monospace



Text in this font denotes text or characters that you should enter from the keyboard, sections of code, programming examples, and syntax examples. This font is also used for the proper names of disk drives, paths, directories, programs, subprograms, subroutines, device names, functions, operations, variables, filenames, and extensions.



Platform



Text in this font denotes a specific platform and indicates that the text following it applies only to that platform.
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Related Documentation Each application software package and driver includes information about writing applications for taking measurements and controlling measurement devices. The following references to documents assume you have NI-DAQmx 9.2 or later, and where applicable, version 8.5 or later of the NI application software.



NI-DAQmx for Windows The DAQ Getting Started guides packaged with NI-DAQmx describe how to install your NI-DAQmx for Windows software, how to install your NI-DAQmx-supported DAQ device, and how to confirm that your device is operating properly. The NI-DAQ Readme lists which devices, ADEs, and NI application software are supported by this version of NI-DAQ. Select Start» All Programs»National Instruments»NI-DAQ»NI-DAQ Readme. The NI-DAQmx Help contains general information about measurement concepts, key NI-DAQmx concepts, and common applications that are applicable to all programming environments. Select Start»All Programs» National Instruments»NI-DAQ»NI-DAQmx Help.



LabVIEW If you are a new user, use the Getting Started with LabVIEW manual to familiarize yourself with the LabVIEW graphical programming environment and the basic LabVIEW features you use to build data acquisition and instrument control applications. Open the Getting Started with LabVIEW manual by selecting Start»All Programs»National Instruments»LabVIEW»LabVIEW Manuals or by navigating to the labview\manuals directory and opening LV_Getting_Started.pdf. Use the LabVIEW Help, available by selecting Help»Search the LabVIEW Help in LabVIEW, to access information about LabVIEW programming concepts, step-by-step instructions for using LabVIEW, and reference information about LabVIEW VIs, functions, palettes, menus, and tools. Refer to the following locations on the Contents tab of the LabVIEW Help for information about NI-DAQmx: •
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Getting Started with LabVIEW»Getting Started with DAQ—Includes overview information and a tutorial to learn how to take an NI-DAQmx measurement in LabVIEW using the DAQ Assistant.
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•



VI and Function Reference»Measurement I/O VIs and Functions» DAQmx - Data Acquisition VIs and Functions—Describes the LabVIEW NI-DAQmx VIs and properties.



•



Taking Measurements—Contains the conceptual and how-to information you need to acquire and analyze measurement data in LabVIEW, including common measurements, measurement fundamentals, NI-DAQmx key concepts, and device considerations.



LabWindows/CVI The Data Acquisition book of the LabWindows/CVI Help contains Taking an NI-DAQmx Measurement in LabWindows/CVI, which includes step-by-step instructions about creating a measurement task using the DAQ Assistant. In LabWindows™/CVI™, select Help»Contents, then select Using LabWindows/CVI»Data Acquisition. This book also contains information about accessing detailed information through the NI-DAQmx Help. The NI-DAQmx Library book of the LabWindows/CVI Help contains API overviews and function reference for NI-DAQmx. Select Library Reference»NI-DAQmx Library in the LabWindows/CVI Help.



Measurement Studio If you program your NI-DAQmx-supported device in Measurement Studio using Visual C++, Visual C#, or Visual Basic .NET, you can interactively create channels and tasks by launching the DAQ Assistant from MAX or from within Visual Studio. You can use Measurement Studio to generate the configuration code based on your task or channel. Refer to the DAQ Assistant Help for additional information about generating code. The NI Measurement Studio Help is fully integrated with the Microsoft Visual Studio help. To view this help file in Visual Studio, select Measurement Studio»NI Measurement Studio Help. For information related to developing with NI-DAQmx, refer to the following topics within the NI Measurement Studio Help:
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•



For step-by-step instructions on how to create an NI-DAQmx application using the Measurement Studio Application Wizard and the DAQ Assistant, refer to Walkthrough: Creating a Measurement Studio NI-DAQmx Application.



•



For help with NI-DAQmx methods and properties, refer to NationalInstruments.DAQmx Namespace, NationalInstruments.DAQmx.ComponentModel Namespace, or NI-DAQmx Visual C++ Class Library Overview.
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•



For conceptual help with NI-DAQmx, refer to Using the Measurement Studio NI-DAQmx .NET Library, Using the Measurement Studio NI-DAQmx Visual C++ Library, or Developing with Measurement Studio NI-DAQmx.



•



For general help with programming in Measurement Studio, refer to Getting Started with the Measurement Studio Class Libraries.



To create an application in Visual Basic .NET, Visual C#, or Visual C++, follow these general steps: 1.



In Visual Studio, select File»New»Project to launch the New Project dialog box.



2.



In the Project types pane, expand the Visual Basic, Visual C#, or Visual C++ node, depending on which language you want to create the project in, and select Measurement Studio.



3.



Choose a project type. You add DAQ tasks as a part of this step.



ANSI C without NI Application Software The NI-DAQmx Help contains API overviews and general information about measurement concepts. Select Start»All Programs»National Instruments»NI-DAQ»NI-DAQmx Help. The NI-DAQmx C Reference Help describes the NI-DAQmx Library functions, which you can use with National Instruments data acquisition devices to develop instrumentation, acquisition, and control applications. Select Start»All Programs»National Instruments»NI-DAQ» Text-Based Code Support»NI-DAQmx C Reference Help.



.NET Languages without NI Application Software With the Microsoft .NET Framework version 1.1 or later, you can use NI-DAQmx to create applications using Visual C# and Visual Basic .NET without Measurement Studio. You need Microsoft Visual Studio .NET 2003 or later for the API documentation to be installed. The installed documentation contains the NI-DAQmx API overview, measurement tasks and concepts, and function reference. This help is fully integrated into the Visual Studio documentation. To view the NI-DAQmx .NET documentation, go to Start»All Programs»National Instruments» NI-DAQ»Text-Based Code Support»NI-DAQmx .NET Help. For function reference, refer to the NationalInstruments.DAQmx Namespace and NationalInstruments.DAQmx.ComponentModel Namespace topics. For conceptual help, refer to the Using the Measurement Studio NI-DAQmx
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.NET Library and Developing with Measurement Studio NI-DAQmx sections. To get to the same help topics from within Visual Studio, go to Help» Contents and select Measurement Studio from the Filtered By drop-down list.



Device Documentation and Specifications The NI 632x Specifications contains all specifications for the NI 6320, NI 6321, and NI 6323 MIO X Series devices. The NI 634x Specifications contains all specifications for the NI 6341 and NI 6343 MIO X Series devices. The NI 6351/6353 Specifications contains all specifications for the NI 6351 and NI 6353 MIO X Series devices. The NI 6356/6358 Specifications contains all specifications for the NI 6356 and NI 6358 Simultaneous MIO X Series devices. The NI 6361/6363 Specifications contains all specifications for the NI 6361 and NI 6363 MIO X Series devices. The NI 6366/6368 Specifications contains all specifications for the NI 6366 and NI 6368 Simultaneous MIO X Series devices. Documentation for supported devices and accessories, including PDF and help files describing device terminals, specifications, features, and operation are on the NI-DAQmx media that includes Device Documentation.



Training Courses If you need more help getting started developing an application with NI products, NI offers training courses. To enroll in a course or obtain a detailed course outline, refer to ni.com/training.
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Technical Support on the Web For additional support, refer to ni.com/support or zone.ni.com. Note



You can download these documents at ni.com/manuals. DAQ specifications and some DAQ manuals are available as PDFs. You must have Adobe Acrobat Reader with Search and Accessibility 5.0.5 or later installed to view the PDFs. Refer to the Adobe Systems Incorporated Web site at www.adobe.com to download Acrobat Reader. Refer to the National Instruments Product Manuals Library at ni.com/manuals for updated documentation resources.
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Getting Started



X Series devices feature up to 32 analog input (AI) channels, up to four analog output (AO) channels, up to 48 lines of digital input/output (DIO), and four counters. This chapter provides basic information you need to get started using your X Series device.



Installation Before installing your DAQ device, you must install the software you plan to use with the device. 1.



Installing application software—Refer to the installation instructions that accompany your software.



2.



Installing NI-DAQmx—The DAQ Getting Started guides, packaged with NI-DAQmx and also on ni.com/manuals, contain step-by-step instructions for installing software and hardware, configuring channels and tasks, and getting started developing an application.



3.



Installing the hardware—Unpack your X Series device as described in the Unpacking section. The DAQ Getting Started guides describe how to install PCI Express, PXI Express, and USB devices, as well as accessories and cables.



Unpacking The X Series device ships in an antistatic package to prevent electrostatic discharge (ESD). ESD can damage several components on the device. Caution



Never touch the exposed pins of connectors. To avoid ESD damage in handling the device, take the following precautions:
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•



Ground yourself with a grounding strap or by touching a grounded object.



•



Touch the antistatic package to a metal part of your computer chassis before removing the device from the package.
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Remove the device from the package and inspect it for loose components or any other signs of damage. Notify NI if the device appears damaged in any way. Do not install a damaged device in your computer or chassis. Store the device in the antistatic package when the device is not in use.



Device Self-Calibration NI recommends that you self-calibrate your X Series device after installation and whenever the ambient temperature changes. Self-calibration should be performed after the device has warmed up for the recommended time period. Refer to the device specifications to find your device warm-up time. This function measures the onboard reference voltage of the device and adjusts the self-calibration constants to account for any errors caused by short-term fluctuations in the environment. You can initiate self-calibration using Measurement & Automation Explorer (MAX), by completing the following steps. 1.



Launch MAX.



2.



Select My System»Devices and Interfaces»your device.



3.



Initiate self-calibration using one of the following methods: •



Click Self-Calibrate in the upper right corner of MAX.



•



Right-click the name of the device in the MAX configuration tree and select Self-Calibrate from the drop-down menu.



You can also programmatically self-calibrate your device with NI-DAQmx, as described in Device Calibration in the NI-DAQmx Help or the LabVIEW Help.



Note
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Getting Started with X Series USB Devices The following sections contain information about X Series USB device best practices and features.



USB Device Chassis Ground Note (NI USB-636x Mass Termination Devices) X Series USB Mass Termination devices have



chassis ground connection through the I/O connector. (NI USB-634x/635x/636x Screw Terminal Devices) For EMC compliance, the



chassis of the X Series USB Screw Terminal device must be connected to earth ground through the chassis ground. The wire should be AWG 16 or larger solid copper wire with a maximum length of 1.5 m (5 ft). Attach the wire to the earth ground of the facility’s power system. For more information about earth ground connections, refer to the KnowledgeBase document, Earth Grounding for Test and Measurement Devices, by going to ni.com/info and entering the Info Code earthground. You can attach and solder a wire to the chassis ground lug of the X Series USB device, as shown in Figure 1-1. The wire should be as short as possible.



Figure 1-1. Grounding an NI USB-634x/635x/636x Screw Terminal Device through the Chassis Ground Lug
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Ferrite Installation (NI USB-636x Mass Termination Devices) To ensure the specified EMC performance for radiated RF emissions of the NI USB-636x Mass Termination device, install the included snap-on ferrite bead onto the power cable, as shown in Figure 1-2.



Ensure that the ferrite bead is as close to the end of the power cable as practical. Install the snap-on ferrite bead by opening the housing and looping the power cable once through the center of the ferrite. Close the ferrite bead until the locking tabs engage securely. You can order additional EMI suppression ferrites, 10.2 mm length (part number 781233-02) from NI.



3



2



1



x1



1 2



Power Cable Ferrite



3



NI USB-636x Mass Termination Device



Figure 1-2. Installing a Ferrite on an NI USB-636x Mass Termination Device
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Mounting X Series USB Devices (NI USB-634x/635x/636x Devices) You can use your X Series USB device on



a desktop, mount it to a wall or panel as described in the Panel/Wall Mounting section, or mount it to a standard DIN rail as described in the DIN Rail Mounting section.



Panel/Wall Mounting Complete the following steps to mount your USB X Series device to a wall or panel using the USB X Series mounting kit (part number 781514-01 not included in your X Series USB device kit). Refer to Figure 1-3. 1.



Use three #8-32 flathead screws to attach the backpanel wall mount to the panel/wall. Tighten the screws with a #2 Phillips screwdriver to a torque of 1.1 N · m (10 lb · in.).



Figure 1-3. Using the USB X Series Mounting Kit on a Wall or Panel
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2.



Place the USB X Series device on the backpanel wall mount with the signal wires facing down and the device bottom sitting on the backpanel wall mount lip.



3.



While holding the USB X Series device in place, attach the front bracket to the backpanel wall mount by tightening the two thumbscrews.
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DIN Rail Mounting Complete the following steps to mount your USB X Series device to a DIN rail using the USB X Series mounting kit with DIN rail clip (part number 781515-01 not included in your X Series USB device kit). 1.



Fasten the DIN rail clip to the back of the backpanel wall mount using a #1 Phillips screwdriver and four machine screws (part number 740981-01), included in the kit as shown in Figure 1-4. Tighten the screws to a torque of 0.4 N · m (3.6 lb · in.).



Figure 1-4. Attaching the DIN Rail Clip to the Backpanel Wall Mount



2.



Clip the bracket onto the DIN rail as shown in Figure 1-5.



1 2 3



1



DIN Rail Clip



2



DIN Rail Spring



3



DIN Rail



Figure 1-5. DIN Rail Clip Parts Locator Diagram
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3.



Place the USB X Series device on the backpanel wall mount with the signal wires facing down and the device bottom sitting on the backpanel wall mount lip.



4.



While holding the USB X Series device in place, attach the front bracket to the backpanel wall mount by tightening the two thumbscrews.



USB Device LEDs (NI USB-634x/635x/636x Devices) Refer to the USB Device LED Patterns



section of Chapter 3, Connector and LED Information, for information about the X Series USB device READY and ACTIVE LEDs.



USB Cable Strain Relief (NI USB-634x/635x/636x Devices) You can provide strain relief for the USB



cable by using the jackscrew on the locking USB cable (included in the X Series USB device kit) to securely attach the cable to the device, as shown in Figure 1-6.



2



1



1



Locking USB Cable Jackscrew



3



2



Jackscrew Hole



3



Security Cable Slot



Figure 1-6. USB Cable Strain Relief on X Series USB Devices
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USB Device Security Cable Slot (NI USB-634x/635x/636x Devices) The security cable slot, shown in Figure 1-6, allows you to attach an optional laptop lock to your X Series USB device. Note The security cable is designed to act as a deterrent, but might not prevent the device from being mishandled or stolen. For more information, refer to the documentation that accompanied the security cable. Note The security cable slot on the USB device might not be compatible with all laptop lock cables.



Device Pinouts Refer to Appendix A, Device-Specific Information, for X Series device pinouts.



Device Specifications Refer to the specifications document for your device: •



NI 632x Specifications



•



NI 634x Specifications



•



NI 6351/6353 Specifications



•



NI 6356/6358 Specifications



•



NI 6361/6363 Specifications



•



NI 6366/6368 Specifications



X Series device documentation is available on the NI-DAQ Device Document Browser or ni.com/manuals.



Device Accessories and Cables NI offers a variety of accessories and cables to use with your DAQ device. Refer to the Cables and Accessories section of Chapter 2, DAQ System Overview, for more information.
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Figure 2-1 shows a typical DAQ system, which includes sensors, transducers, signal conditioning devices, cables that connect the various devices to the accessories, the X Series device, programming software, and PC. The following sections cover the components of a typical DAQ system.



Sensors and Transducers



Signal Conditioning



Cables and Accessories



DAQ Hardware



DAQ Software



Personal Computer or PXI Express Chassis



Figure 2-1. Components of a Typical DAQ System



DAQ Hardware DAQ hardware digitizes signals, performs D/A conversions to generate analog output signals, and measures and controls digital I/O signals. Figure 2-2 features components common to all X Series devices.
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Analog Input



I/O Connector



Analog Output



Digital I/O



Digital Routing and Clock Generation



Bus Interface



Bus



Counters RTSI PFI



Figure 2-2. General X Series Block Diagram



DAQ-STC3 The DAQ-STC3 and DAQ-6202 implement a high-performance digital engine for X Series data acquisition hardware. Some key features of this engine include the following:
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•



Flexible AI and AO sample and convert timing



•



Many triggering modes



•



Independent AI, AO, DI, DO, and counter FIFOs



•



Generation and routing of RTSI signals for multi-device synchronization



•



Generation and routing of internal and external timing signals



•



Four flexible 32-bit counter/timer modules with hardware gating



•



Digital waveform acquisition and generation



•



Static DIO signals



•



True 5 V high current drive DO



•



DI change detection



•



DO watchdog timers



•



PLL for clock synchronization



•



Seamless interface to signal conditioning accessories



•



PCI Express/PXI Express interface



•



Independent scatter-gather DMA controllers for all acquisition and generation functions 2-2
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Calibration Circuitry The X Series analog inputs and outputs have calibration circuitry to correct gain and offset errors. You can calibrate the device to minimize AI and AO errors caused by time and temperature drift at run time. No external circuitry is necessary; an internal reference ensures high accuracy and stability over time and temperature changes. Factory-calibration constants are permanently stored in an onboard EEPROM and cannot be modified. When you self-calibrate the device, as described in the Device Self-Calibration section of Chapter 1, Getting Started, software stores new constants in a user-modifiable section of the EEPROM. To return a device to its initial factory calibration settings, software can copy the factory-calibration constants to the user-modifiable section of the EEPROM. Refer to the NI-DAQmx Help or the LabVIEW Help for more information about using calibration constants. For a detailed calibration procedure for X Series devices, refer to the B/E/M/S/X Series Calibration Procedure by clicking Manual Calibration Procedures on ni.com/calibration.



Cables and Accessories Refer to the PCI Express, PXI Express, and USB Mass Termination Device Cables and Accessories section for X Series PCI Express, PXI Express, and USB Mass Termination device cable and accessory information. Refer to the USB Screw Terminal Device Accessories section for X Series USB Screw Terminal device accessory information.



PCI Express, PXI Express, and USB Mass Termination Device Cables and Accessories For compliance with Electromagnetic Compatibility (EMC) requirements, this product must be operated with shielded cables and accessories. If unshielded cables or accessories are used, the EMC specifications are no longer guaranteed unless all unshielded cables and/or accessories are installed in a shielded enclosure with properly designed and shielded input/output ports. Caution
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NI offers a variety of products to use with X Series PCI Express, PXI Express, and USB Mass Termination devices, including cables, connector blocks, and other accessories, as follows: •



Shielded cables and cable assemblies, and unshielded ribbon cables and cable assemblies



•



Screw terminal connector blocks, shielded and unshielded



•



RTSI bus cables



•



SCXI modules and accessories for isolating, amplifying, exciting, and multiplexing signals; with SCXI you can condition and acquire up to 3,072 channels



•



Low-channel-count signal conditioning modules, devices, and accessories, including conditioning for strain gauges and RTDs, simultaneous sample and hold circuitry, and relays



For more specific information about these products, refer to ni.com. Refer to the Custom Cabling and Connectivity section of this chapter and the Field Wiring Considerations section of Chapter 4, Analog Input, for information about how to select accessories for your X Series device. This section describes some cable and accessory options for X Series devices with one or two 68-pin connectors. Refer to ni.com for other accessory options including new devices.



SCXI Accessories SCXI is a programmable signal conditioning system designed for measurement and automation applications. To connect your X Series device to an SCXI chassis, use the SCXI-1349 adapter and an SHC68-68-EPM cable. Note (NI 6356/6358/6366/6368 Devices) Simultaneous MIO (SMIO) X Series devices only support controlling SCXI in parallel mode.



Use Connector 0 of your X Series device to control SCXI in parallel and multiplexed mode. NI-DAQmx only supports SCXI in parallel mode on Connector 1. When using Connector 1 in parallel mode with SCXI modules that support track and hold, you must programmatically disable track and hold.



Note



Refer to the SCXI Advisor, available by going to ni.com/info and entering the Info Code rdscad, for more information. X Series User Manual
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SCC Accessories SCC provides portable, modular signal conditioning to your DAQ system. Use an SHC68-68-EPM shielded cable to connect your X Series device to an SCC module carrier, such as the following: •



SC-2345



•



SC-2350



•



SCC-68



You can use either connector on MIO X Series devices to control an SCC module carrier with NI-DAQmx. Note PCI Express users should consider the power limits on certain SCC modules without an external power supply. Refer to the specifications document for your device, and the PCI Express Device Disk Drive Power Connector section of Chapter 3, Connector and LED Information, for information about power limits and increasing the current the device can supply on the +5 V terminal. Note (NI 6356/6358/6366/6368 Devices) Simultaneous MIO X Series devices do not



support SCC. Refer to the SCC Configuration Guide, available by going to ni.com/ info and entering the Info Code rdscav, for more information.



BNC Accessories You can use the SHC68-68-EPM shielded cable, to connect your DAQ device to BNC accessories, such as the following: •



BNC-2110—Provides BNC connectivity to all analog signals, some digital signals, and spring terminals for other digital signals



•



BNC-2111—Provides BNC connectivity to 16 single-ended analog input signals, two analog output signals, five DIO/PFI signals, and the external reference voltage for analog output



•



BNC-2120—Similar to the BNC-2110, and also has a built-in function generator, quadrature encoder, temperature reference, and thermocouple connector



•



BNC-2090A—Desktop/rack-mountable device with 22 BNCs for connecting analog, digital, and timing signals



You can use one BNC accessory with the signals on either connector of your X Series device. You can use two BNC accessories with one X Series device by using both connectors.
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Screw Terminal Accessories National Instruments offers several styles of screw terminal connector blocks. Use an SHC68-68-EPM shielded cable to connect an X Series device to a connector block, such as the following: •



CB-68LP and CB-68LPR—Unshielded connector blocks



•



SCC-68—I/O connector block with screw terminals, general breadboard area, bus terminals, and four expansion slots for SCC signal conditioning modules



•



SCB-68—Shielded connector block with temperature sensor



•



TBX-68—DIN rail-mountable connector block



•



TB-27061—Front panel mounted terminal block for X Series PXI Express devices



You can use one screw terminal accessory with the signals on either connector of your X Series device. You can use two screw terminal accessories with one X Series device by using both connectors.



RTSI Cables Use RTSI bus cables to connect timing and synchronization signals among PCI/PCI Express devices, such as X Series, M Series, CAN, and other measurement, vision, and motion devices. Since PXI devices use PXI backplane signals for timing and synchronization, no cables are required.



Cables In most applications, you can use the following cables:



1 2



•



SHC68-68-EPM2—High-performance shielded cable designed for M/X Series devices. It has individual bundles separating analog and digital signals. Each differential analog input channel is routed on an individually shielded twisted pair of wires. Analog outputs are also individually shielded



•



SHC68-68—Lower-cost shielded cable with 34 twisted pairs of wire



•



RC68-68—Highly-flexible unshielded ribbon cable



TB-2706 uses Connector 0 of your PXI Express device. After a TB-2706 is installed, Connector 1 cannot be used. NI recommends that you use the SHC68-68-EPM cable; however, an SHC68-68-EP cable will work with X Series devices.
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Custom Cabling and Connectivity The CA-1000 is a configurable enclosure that gives user-defined connectivity and flexibility through customized panelettes. Visit ni.com for more information about the CA-1000. NI offers cables and accessories for many applications. However, if you want to develop your own cable, adhere to the following guidelines for best results: •



For AI signals, use shielded, twisted-pair wires for each AI pair of differential inputs. Connect the shield for each signal pair to the ground reference at the source.



•



Route the analog lines separately from the digital lines.



•



When using a cable shield, use separate shields for the analog and digital sections of the cable. Failure to do so results in noise coupling into the analog signals from transient digital signals.



For more information about the connectors used for DAQ devices, refer to the KnowledgeBase document, Specifications and Manufacturers for Board Mating Connectors, by going to ni.com/info and entering the Info Code rdspmb.



USB Device Mounting Accessories, USB Cable, Power Supply, and Ferrite NI offers a variety of products to use with USB Mass Termination X Series devices, as follows:
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•



USB X Series mounting kit—Part number 781514-01



•



USB X Series mounting kit with DIN rail clip—Part number 781515-01



•



USB cable with locking screw, 2 m—Part number 780534-01



•



Universal power supply with mini-combicon connector, 12 VDC, 2.5 A—Part number 781513-01



•



EMI suppression ferrites, 10.2 mm length—Part number 781233-02



2-7



X Series User Manual



Chapter 2



DAQ System Overview



USB Screw Terminal Device Accessories NI offers a variety of products to use with USB Screw Terminal X Series devices, as follows: •



USB X Series mounting kit—Part number 781514-01



•



USB X Series mounting kit with DIN rail clip—Part number 781515-01



•



USB cable with locking screw, 2 m—Part number 780534-01



•



Universal power supply with mini-combicon connector, 12 VDC, 2.5 A—Part number 781513-01



Signal Conditioning Many sensors and transducers require signal conditioning before a measurement system can effectively and accurately acquire the signal. The front-end signal conditioning system can include functions such as signal amplification, attenuation, filtering, electrical isolation, simultaneous sampling, and multiplexing. In addition, many transducers require excitation currents or voltages, bridge completion, linearization, or high amplification for proper and accurate operation. Therefore, most computer-based measurement systems include some form of signal conditioning in addition to plug-in data acquisition DAQ devices.



Sensors and Transducers Sensors can generate electrical signals to measure physical phenomena, such as temperature, force, sound, or light. Some commonly used sensors are strain gauges, thermocouples, thermistors, angular encoders, linear encoders, and resistance temperature detectors (RTDs). To measure signals from these various transducers, you must convert them into a form that a DAQ device can accept. For example, the output voltage of most thermocouples is very small and susceptible to noise. Therefore, you may need to amplify or filter the thermocouple output before digitizing it. The manipulation of signals to prepare them for digitizing is called signal conditioning.
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For more information about sensors, refer to the following documents: •



For general information about sensors, visit ni.com/sensors.



•



If you are using LabVIEW, refer to the LabVIEW Help by selecting Help»Search the LabVIEW Help in LabVIEW and then navigate to the Taking Measurements book on the Contents tab.



•



If you are using other application software, refer to Common Sensors in the NI-DAQmx Help or the LabVIEW Help.



Signal Conditioning Options SCXI SCXI is a front-end signal conditioning and switching system for various measurement devices, including X Series devices. An SCXI system consists of a rugged chassis that houses shielded signal conditioning modules that amplify, filter, isolate, and multiplex analog signals from thermocouples or other transducers. SCXI is designed for large measurement systems or systems requiring high-speed acquisition. Note (NI 6356/6358/6366/6368 Devices) Simultaneous MIO (SMIO) X Series devices only support controlling SCXI in parallel mode.



System features include the following: •



Modular architecture—Choose your measurement technology



•



Expandability—Expand your system to 3,072 channels



•



Integration—Combine analog input, analog output, digital I/O, and switching into a single, unified platform



•



High bandwidth—Acquire signals at high rates



•



Connectivity—Select from SCXI modules with thermocouple connectors or terminal blocks



SCC SCC is a front-end signal conditioning system for X Series plug-in data acquisition devices. An SCC system consists of a shielded carrier that holds up to 20 single- or dual-channel SCC modules for conditioning thermocouples and other transducers. SCC is designed for small measurement systems where you need only a few channels of each signal type, or for portable applications. SCC systems also offer the most comprehensive and flexible signal connectivity options.
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System features include the following: •



Modular architecture—Select your measurement technology on a per-channel basis



•



Small-channel systems—Condition up to 16 analog input and eight digital I/O lines



•



Low-profile/portable—Integrates well with other laptop computer measurement technologies



•



Connectivity—Incorporates panelette technology to offer custom connectivity to thermocouple, BNC, LEMO™ (B Series), and MIL-Spec connectors



(PCI Express X Series Devices) PCI Express users should consider the power limits on certain SCC modules without an external power supply. Refer to the specifications for your device, and the PCI Express Device Disk Drive Power Connector section of Chapter 3, Connector and LED Information, for information about power limits and increasing the current the device can supply on the +5 V terminal. Note



Note



(NI 6356/6358/6366/6368 Devices) X Series Simultaneous MIO (SMIO) devices do not



support SCC.



Programming Devices in Software National Instruments measurement devices are packaged with NI-DAQmx driver software, an extensive library of functions and VIs you can call from your application software, such as LabVIEW or LabWindows/CVI, to program all the features of your NI measurement devices. Driver software has an application programming interface (API), which is a library of VIs, functions, classes, attributes, and properties for creating applications for your device. X Series devices use the NI-DAQmx driver. NI-DAQmx includes a collection of programming examples to help you get started developing an application. You can modify example code and save it in an application. You can use examples to develop a new application or add example code to an existing application. To locate LabVIEW, LabWindows/CVI, Measurement Studio, Visual Basic, and ANSI C examples, refer to the KnowledgeBase document, Where Can I Find NI-DAQmx Examples?, by going to ni.com/info and entering the Info Code daqmxexp. For additional examples, refer to zone.ni.com.
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Table 2-1 lists the earliest NI-DAQmx support version for each X Series device. Table 2-1. X Series NI-DAQmx Software Support



Device



NI-DAQmx Version Support



NI PCIe/PXIe-632x/634x



NI-DAQmx 9.0 and later



NI PCIe/PXIe-6351/6353/6361/6363



NI-DAQmx 9.0 and later



NI PXIe-6356/6358/6366/6368



NI-DAQmx 9.0.2 and later



NI USB-6361/6363 Mass Termination



NI-DAQmx 9.5 and later



NI USB-6366 Mass Termination



NI-DAQmx 9.5 and later



NI USB-634x/6351/6353/6361/6363 Screw Terminal



NI-DAQmx 9.2 and later



NI USB-6356/6366 Screw Terminal



NI-DAQmx 9.2.1 and later
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The I/O Connector Signal Descriptions and +5 V Power Source sections contain information about X Series connector signals and power. Refer to Appendix A, Device-Specific Information, for device I/O connector pinouts. The PCI Express Device Disk Drive Power Connector and RTSI Connector Pinout sections refer to X Series PCI Express device power and the RTSI connector on PCI Express devices. The USB Device LED Patterns section refers to the X Series USB device READY and ACTIVE LEDs.



I/O Connector Signal Descriptions Table 3-1 describes the signals found on the I/O connectors. Not all signals are available on all devices.
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Table 3-1. I/O Connector Signals Signal Name AI GND



AI 



Reference



Direction



Description



—



—



Analog Input Ground—These terminals are the reference point for single-ended AI measurements in RSE mode and the bias current return point for DIFF measurements. All three ground references—AI GND, AO GND, and D GND—are connected on the device.*



Varies



Input



Analog Input Channels 0 to 31 (MIO X Series Devices) For single-ended measurements, each signal is an analog input voltage channel. In RSE mode, AI GND is the reference for these signals. In NRSE mode, the reference for each AI signal is AI SENSE; the reference for each AI signal is AI SENSE 2. For differential measurements on MIO X Series devices, AI 0 and AI 8 are the positive and negative inputs of differential analog input channel 0. Similarly, the following signal pairs also form differential input channels: AI , AI , AI , AI , AI , AI , AI , AI , AI , AI , AI , AI , AI , AI , AI Also refer to the Connecting Ground-Referenced Signal Sources section of Chapter 4, Analog Input. (Simultaneous MIO X Series Devices) For differential measurements on Simultaneous MIO X Series devices, AI 0+ and AI 0– are the positive and negative inputs of differential analog input channel 0. Also refer to the Connecting Analog Input Signals section of Chapter 4, Analog Input.



AI SENSE, AI SENSE 2



AO 



—



AO GND



Input



Analog Input Sense—In NRSE mode, the reference for each AI signal is AI SENSE; the reference for each AI signal is AI SENSE 2. Also refer to the Connecting Ground-Referenced Signal Sources section of Chapter 4, Analog Input.



Output



Analog Output Channels 0 to 3—These terminals supply the voltage output of AO channels 0 to 3.



AO GND



—



—



Analog Output Ground—AO GND is the reference for AO . All three ground references—AI GND, AO GND, and D GND—are connected on the device.*



D GND



—



—



Digital Ground—D GND supplies the reference for P0., PFI /P1/P2, and +5 V. All three ground references—AI GND, AO GND, and D GND—are connected on the device.*



P0.
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Table 3-1. I/O Connector Signals (Continued) Signal Name



Reference



Direction



Description



APFI 



AO GND or AI GND



Input



Analog Programmable Function Interface Channels 0 to 1—Each APFI signal can be used as AO external reference inputs for AO , or as an analog trigger input. APFI are referenced to AI GND when they are used as analog trigger inputs. APFI are referenced to AO GND when they are used as AO external offset or reference inputs. These functions are not available on all devices. Refer to the specifications for your device.



+5 V



D GND



Output



+5 V Power Source—These terminals provide a fused +5 V power source. Refer to the +5 V Power Source section for more information.



PFI /P1. PFI /P2.



D GND



Input or Output



Programmable Function Interface or Digital I/O Channels 0 to 7 and Channels 8 to 15—Each of these terminals can be individually configured as a PFI terminal or a digital I/O terminal. As an input, each PFI terminal can be used to supply an external source for AI, AO, DI, and DO timing signals or counter/timer inputs. As a PFI output, you can route many different internal AI, AO, DI, or DO timing signals to each PFI terminal. You also can route the counter/timer outputs to each PFI terminal. As a Port 1 or Port 2 digital I/O signal, you can individually configure each signal as an input or output.



NC



—



—



No connect—Do not connect signals to these terminals.



* Though AI GND, AO GND, and D GND are connected on the X Series device, they are connected by small traces to reduce



crosstalk between subsystems. Each ground has a slight difference in potential.



+5 V Power Source The +5 V terminals on the I/O connector supply +5 V referenced to D GND. Use these terminals to power external circuitry. Caution Never connect the +5 V power terminals to analog or digital ground or to any other voltage source on the X Series device or any other device. Doing so can damage the device and the computer. NI is not liable for damage resulting from such a connection.



The power rating on most devices is +4.75 VDC to +5.25 VDC at 1 A. Refer to the specifications document for your device to obtain the device power rating.
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Note (PCI Express X Series Devices) PCI Express X Series devices supply less than 1 A of +5 V power unless you use the disk drive power connector. Refer to the PCI Express Device Disk Drive Power Connector section for more information.



PCI Express Device Disk Drive Power Connector (NI PCIe-632x/634x/635x/636x Devices) The disk drive power connector is a



four-pin hard drive connector on PCI Express devices that, when connected, increases the current the device can supply on the +5 V terminal.



When to Use the Disk Drive Power Connector PCI Express X Series devices without the disk drive power connector installed perform identically to other X Series devices for most applications and with most accessories. For most applications, it is not necessary to install the disk drive power connector. However, you should install the disk drive power connector in either of the following situations: •



You need more power than listed in the device specifications



•



You are using an SCC accessory without an external power supply, such as the SC-2345



Refer to the specifications document for your device for more information about PCI Express power requirements and current limits.



Disk Drive Power Connector Installation Before installing the disk drive power connector, you must install and set up the PCI Express X Series device as described in the DAQ Getting Started guides. Complete the following steps to install the disk drive power connector. 1.



Power off and unplug the computer.



2.



Remove the computer cover.



3.



Attach the PC disk drive power connector to the disk drive power connector on the device, as shown in Figure 3-1.



The power available on the disk drive power connectors in a computer can vary. For example, consider using a disk drive power connector that is not in the same power chain as the hard drive.



Note
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1



1
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Device Disk Drive Power Connector



2



PC Disk Drive Power Connector



Figure 3-1. Connecting to the Disk Drive Power Connector



4.



Replace the computer cover, and plug in and power on the computer.



RTSI Connector Pinout (NI PCIe-632x/634x/635x/636x Devices) Refer to the RTSI Connector Pinout



section of Chapter 9, Digital Routing and Clock Generation, for information about the RTSI connector on PCI Express X Series devices.



USB Device LED Patterns (NI USB-634x/635x/636x Devices) X Series USB devices have LEDs labeled ACTIVE and READY. The ACTIVE LED indicates activity over the bus. The READY LED indicates whether or not the device is configured. Table 3-2 shows the behavior of the LEDs. Table 3-2. LED Patterns



ACTIVE LED



READY LED



Off



Off



The device is not powered or not connected to the host computer, or the host computer does not have the correct version of NI-DAQmx. Refer to Table 2-1, X Series NI-DAQmx Software Support, for the NI-DAQmx support information for your device.



Off



On



The device is configured, but there is no activity over the bus.



On



On



The device is configured and there is activity over the bus.



Blinking



On
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Refer to one of the following sections, depending on your device: •



Analog Input on MIO X Series Devices—NI 632x/634x/6351/ 6353/6361/6363 devices can be configured for single-ended and differential analog input measurements.



•



Analog Input on Simultaneous MIO X Series Devices—NI 6356/ 6358/6366/6368 devices can be configured for differential analog input simultaneous sampled measurements.



Analog Input on MIO X Series Devices



I/O Connector



Figure 4-1 shows the analog input circuitry of MIO X Series devices.



AI 



Mux DIFF, RSE, or NRSE



NI-PGIA



ADC



AI Data



AI FIFO



AI SENSE Input Range Selection



AI GND AI Terminal Configuration Selection



Figure 4-1. MIO X Series Analog Input Circuitry



The main blocks featured in the MIO X Series device analog input circuitry are as follows: •
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I/O Connector—You can connect analog input signals to the MIO X Series device through the I/O connector. The proper way to connect analog input signals depends on the analog input ground-reference settings, described in the Analog Input Ground-Reference Settings section. Also refer to Appendix A, Device-Specific Information, for device I/O connector pinouts.
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•



Mux—Each MIO X Series device has one analog-to-digital converter (ADC). The multiplexers (mux) route one AI channel at a time to the ADC through the NI-PGIA.



•



Ground-Reference Settings—The analog input ground-reference settings circuitry selects between differential, referenced single-ended, and non-referenced single-ended input modes. Each AI channel can use a different mode.



•



Instrumentation Amplifier (NI-PGIA)—The NI programmable gain instrumentation amplifier (NI-PGIA) is a measurement and instrument class amplifier that minimizes settling times for all input ranges. The NI-PGIA can amplify or attenuate an AI signal to ensure that you use the maximum resolution of the ADC. MIO X Series devices use the NI-PGIA to deliver high accuracy even when sampling multiple channels with small input ranges at fast rates. MIO X Series devices can sample channels in any order, and you can individually program each channel in a sample with a different input range.



•



A/D Converter—The analog-to-digital converter (ADC) digitizes the AI signal by converting the analog voltage into a digital number.



•



AI FIFO—MIO X Series devices can perform both single and multiple A/D conversions of a fixed or infinite number of samples. A large first-in-first-out (FIFO) buffer holds data during AI acquisitions to ensure that no data is lost. MIO X Series devices can handle multiple A/D conversion operations with DMA or programmed I/O.



Analog Input Range Input range refers to the set of input voltages that an analog input channel can digitize with the specified accuracy. The NI-PGIA amplifies or attenuates the AI signal depending on the input range. You can individually program the input range of each AI channel on your MIO X Series device. The input range affects the resolution of the MIO X Series device for an AI channel. Resolution refers to the voltage of one ADC code. For example, a 16-bit ADC converts analog inputs into one of 65,536 (= 216) codes—that is, one of 65,536 possible digital values. These values are spread fairly evenly across the input range. So, for an input range of –10 V to 10 V, the voltage of each code of a 16-bit ADC is: 10V – ( – 10V ) ---------------------------------- = 305 μV 16 2
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MIO X Series devices use a calibration method that requires some codes (typically about 5% of the codes) to lie outside of the specified range. This calibration method improves absolute accuracy, but it increases the nominal resolution of input ranges by about 5% over what the formula shown above would indicate. Choose an input range that matches the expected input range of your signal. A large input range can accommodate a large signal variation, but reduces the voltage resolution. Choosing a smaller input range improves the voltage resolution, but may result in the input signal going out of range. For more information about setting ranges, refer to the NI-DAQmx Help or the LabVIEW Help. Table 4-1 shows the input ranges and resolutions supported by each MIO X Series device. Table 4-1. MIO X Series Device Input Range and Nominal Resolution



MIO X Series Device



Input Range



Nominal Resolution Assuming 5% Over Range



NI 632x/634x



–10 V to 10 V



320 μV



–5 V to 5 V



160 μV



–1 V to 1 V



32 μV



–200 mV to 200 mV



6.4 μV



–10 V to 10 V



320 μV



–5 V to 5 V



160 μV



–2 V to 2 V



64 μV



–1 V to 1 V



32 μV



–500 mV to 500 mV



16 μV



–200 mV to 200 mV



6.4 μV



–100 mV to 100 mV



3.2 μV



NI 6351/6353/6361/6363
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Working Voltage Range On most MIO X Series devices, the PGIA operates normally by amplifying signals of interest while rejecting common-mode signals under the following three conditions: •



The common-mode voltage (Vcm), which is equivalent to subtracting AI GND from AI –, must be less than ±10 V. This Vcm is a constant for all range selections.



•



The signal voltage (Vs), which is equivalent to subtracting AI + from AI –, must be less than or equal to the range selection of the given channel. If Vs is greater than the range selected, the signal clips and information are lost.



•



The total working voltage of the positive input, which is equivalent to (Vcm + Vs), or subtracting AI GND from AI +, must be less than ±11 V.



If any of these conditions are exceeded, the input voltage is clamped until the fault condition is removed.



Analog Input Ground-Reference Settings MIO X Series devices support the following analog input ground-reference settings: •



Differential mode—In DIFF mode, the MIO X Series device measures the difference in voltage between two AI signals.



•



Referenced single-ended mode—In RSE mode, the MIO X Series device measures the voltage of an AI signal relative to AI GND.



•



Non-referenced single-ended mode—In NRSE mode, the MIO X Series device measures the voltage of an AI signal relative to one of the AI SENSE or AI SENSE 2 inputs.



The AI ground-reference setting determines how you should connect your AI signals to the MIO X Series device. Refer to the Connecting Analog Input Signals section for more information. Ground-reference settings are programmed on a per-channel basis. For example, you might configure the device to scan 12 channels—four differentially-configured channels and eight single-ended channels. MIO X Series devices implement the different analog input ground-reference settings by routing different signals to the NI-PGIA. The NI-PGIA is a differential amplifier. That is, the NI-PGIA amplifies (or attenuates) the difference in voltage between its two inputs. The NI-PGIA
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drives the ADC with this amplified voltage. The amount of amplification (the gain), is determined by the analog input range, as shown in Figure 4-2.



Vin+ +



PGIA



Vm Measured Voltage



Vin–



– Vm = [Vin+ – Vin–] × Gain



Figure 4-2. MIO X Series Device NI-PGIA



Table 4-2 shows how signals are routed to the NI-PGIA on MIO X Series devices. Table 4-2. Signals Routed to the NI-PGIA on MIO X Series Devices



AI Ground-Reference Settings



Signals Routed to the Positive Input of the NI-PGIA (Vin+)



Signals Routed to the Negative Input of the NI-PGIA (Vin–)



RSE



AI 



AI GND



NRSE



AI 



AI SENSE



AI 



AI SENSE 2



AI 



AI 



AI 



AI 



DIFF



For differential measurements, AI 0 and AI 8 are the positive and negative inputs of differential analog input channel 0. For a complete list of signal pairs that form differential input channels, refer to the I/O Connector Signal Descriptions section of Chapter 3, Connector and LED Information. Caution The maximum input voltages rating of AI signals with respect to ground (and for signal pairs in differential mode with respect to each other) are listed in the specifications document for your device. Exceeding the maximum input voltage of AI signals distorts the measurement results. Exceeding the maximum input voltage rating also can damage the device and the computer. NI is not liable for any damage resulting from such signal connections.
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AI ground-reference setting is sometimes referred to as AI terminal configuration.



Configuring AI Ground-Reference Settings in Software You can program channels on an MIO X Series device to acquire with different ground references. To enable multimode scanning in LabVIEW, use NI-DAQmx Create Virtual Channel.vi of the NI-DAQmx API. You must use a new VI for each channel or group of channels configured in a different input mode. In Figure 4-3, channel 0 is configured in differential mode, and channel 1 is configured in RSE mode.



Figure 4-3. Enabling Multimode Scanning in LabVIEW



To configure the input mode of your voltage measurement using the DAQ Assistant, use the Terminal Configuration drop-down list. Refer to the DAQ Assistant Help for more information about the DAQ Assistant. To configure the input mode of your voltage measurement using the NI-DAQmx C API, set the terminalConfig property. Refer to the NI-DAQmx C Reference Help for more information.



Multichannel Scanning Considerations MIO X Series devices can scan multiple channels at high rates and digitize the signals accurately. However, you should consider several issues when designing your measurement system to ensure the high accuracy of your measurements. In multichannel scanning applications, accuracy is affected by settling time. When your MIO X Series device switches from one AI channel to another AI channel, the device configures the NI-PGIA with the input range of the new channel. The NI-PGIA then amplifies the input signal with the gain for the new input range. Settling time refers to the time it takes the
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NI-PGIA to amplify the input signal to the desired accuracy before it is sampled by the ADC. The specifications document for your DAQ device lists its settling time. MIO X Series devices are designed to have fast settling times. However, several factors can increase the settling time which decreases the accuracy of your measurements. To ensure fast settling times, you should do the following (in order of importance): 1.



Use Low Impedance Sources—To ensure fast settling times, your signal sources should have an impedance of 
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